
 

  

PowerPoint is currently the most common software used for making visual aids for 
presentations. It has been redesigned for the 2007 release with a much more user-friendly and 
intuitive layout than its predecessors.  

This tutorial will teach you the basic tools for making a PowerPoint presentation and familiarize 
you with the new PowerPoint 2007 workspace. 

 

Basic Tips 

 It is best to outline your entire presentation before working too much on the style and 
layout of your presentation. When left to the end it is much less time consuming to work 
on the style and format of your slides. Keep in mind the content of your presentation is the 
most important part of it! 
 

 Keep your points short and straightforward. Points should be complimentary to your oral 
presentation. 
 

 PowerPoint allows you to add a lot of distracting sounds and excessive animations to your 
presentation. It is best to keep all animation as simple as possible and only use 
sounds if absolutely necessary. 
 

 Stay away from unusual fonts. If you are presenting on an unfamiliar computer, the font 
you have chosen may not work. Arial and Times New Roman are common fonts. 
 

 Think of contrast. If you use a dark background, use light-coloured text and vice versa. 
Refrain from using backgrounds that will obscure your text colour. 

 
 

Microsoft Interactive Online Demos 
 
Microsoft has developed a series of online demo programs to assist people with the transition to 
Office 2007. 
 

 Start the Guide for a program by clicking on that phrase on the webpages listed below 

 A new window will open in your web browser showing Office 2003 

 Use the familiar Toolbar from Office 2003 to find a Tool 

 A second window will appear to show you how to use the same Tool in Office 2007 
 
The web address for the PowerPoint Guide is: 
 

 http://office.microsoft.com/en-us/powerpoint/HA101490761033.aspx 
 

Microsoft PowerPoint 2007 
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MS PowerPoint 2007 New Interface 

When you open PowerPoint 2007, you will notice that it looks quite different from PowerPoint 2000 and 

PowerPoint 2003. The same tools are all there, but they are arranged very differently and new features have 

been added. 

If you are already familiar with PowerPoint 2000 or 2003, it may take you a while to adjust to this new 

arrangement of tools. This tutorial uses PowerPoint 2007 and you can use it as a quick reference guide for 

most of the common tools.  

Arrangement of Tools in PowerPoint 2007 

 

 
MS OFFICE BUTTON contains the main File Functions: 

 New, Open, Save, Save as, Print, Print Preview, etc. 
  
QUICK ACCESS TOOLBAR contains shortcuts to Save, Undo, and Repeat 
 
RIBBON TABS - Each Ribbon Tab displays a Ribbon that 
provides a set of Tool Groups. The Ribbon Tab and the Tool 
Groups correspond to the Menu and Toolbar in previous 
versions of Excel. 
 

 Tool Groups - Each Tool Group's name is shown at the 
bottom of the Group 
o Example - Home Tab 
o Both the Clipboard and Font Tool Groups display their 

names at the bottom of their Group (see image at right) 

 To Change Tool Groups click on the appropriate Ribbon Tab in the Ribbon  
o Examples 

 Home Tab - Tool Groups for ClipBoard, Font, Alignment, and Cell Formatting 
 Insert Tab - Tool Groups for inserting Images, Charts, and Text Boxes 

 Dialog Box Launch Arrow 
o Some Tool Groups have a small arrow in the bottom right-hand corner 
o Clicking on this arrow will open a Dialog Box which offers   

more options and settings related to that Tool Group 
 

In PowerPoint 2007, you will find that tools with similar uses are organized so that they are usually found within 

the same Tool Group or at least within one Ribbon. If you do not find a tool in the Ribbon you think it should be 

in, try exploring the other Ribbon Tabs. 

Dialog Box 

Launch Arrow 
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Getting Started 

Create a new presentation 
 

MS Office Button >> New 
A new Presentation window opens up 

 The MS Office Button is located in the top left corner of the 
Word 2007 Window 

To start a new file from scratch:  

 Choose “Blank Document” and press “Create”.  
 

There are templates available on the left panel for creating a presentation of a 
specific type (i.e. photo album or calendar). 

Open an existing 
presentation 

MS Office Button >> Open 

 Find your presentation in the “Open” window.  

 PowerPoint 2007 will open files created with older versions of PowerPoint 
(.ppt) as well as PowerPoint 2007 files (.pptx) 

Open a file from a different 

version or format 

PowerPoint 2007 will automatically convert a document from a compatible 
version of PowerPoint 

 Your document will open in Compatibility Mode 

 This will prevent you from using certain tools in Office 2007 which are not 
compatible with Office 2000 or 2003 

 When you finish editing a document, be VERY CAREFUL to save any 
converted documents in their original format 

 Please read the Important Notes below regarding saving in Office 2007. 

IMPORTANT NOTES:  Saving Documents in PowerPoint 2007 

1. In the Computing Facilities, files on the Desktop are NOT SAVED when you log off. 

 ALWAYS use MS Office Button >> Save As... to save your file to a storage device or server 

 You can also save a file to the Desktop and then email it to yourself with the file as an attachment 
 

2. If you are NOT running Office 2007 at home and you save a document as PowerPoint 2007 (*.pptx),  
YOU WILL NOT BE ABLE TO OPEN IT AT HOME! (see step 3 below) 
 

3. If you have Office 2000 or 2003 or you use a Mac at home or in the Computing Facilities 

 You will have to save your document as an older version 

 Go to MS Office Button >> Save As... 
o At the bottom, there is a bar that asks you to “Save as Type:” 
o Choose PowerPoint 97-2003 Document (*.ppt) 

 DO NOT CHOOSE “PowerPoint Document (*.pptx)” 
 

4. If you are using a PC at home running Office 2000 or 2003 

 You can download the MS Office 2007 to Office 2003 Compatibility Pack from Microsoft's website 
o http://www.microsoft.com/downloads/ 
o Under New Downloads, choose "Microsoft Office Compatibility Pack for Word..." 

 Even with the Compatibility Pack, you might lose data / formatting when you save as an older version 

 There is no Compatibility Pack available for Mac yet. 

Save the current document MS Office Button >> Save 
 

 Please read the Important Notes above regarding saving in 
Office 2007 

Save a document under a 
different name, version, or 
format 

MS Office Button >> Save As... 
 

 In the bars at the bottom of the Save As... Dialog Box: 
o Give your document a new name in “File Name:” 
o Select the version and format from “Save as type:” 
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Add a new slide Home Tab >> Slides Group >> New Slide  
 

 Click on the New Slide Tool. It adds a new slide in the default layout "Title 
and Content.” 

 Click on the arrow at the bottom corner of the New Slide Tool. You can 
select the layout for the new slide from the .  

 Click the Layout button. You can select and change the slide layout. 

 Click the Delete button to delete the current slides. 

 Viewing Slides in PowerPoint 2007 Workspace 

Layout of frames in “Normal 
View” 

When you first open a new presentation in PowerPoint the main window is in 
Normal View and should show three frames: 
 

 The larger frame on the right shows the Current Slide. 

 The left frame has two tabs: 
o Slides tab - displays the slides as thumbnails 
o Outline tab - displays a written outline for each slide of your 

presentation. 

 The bottom frame is for Notes to remind you of points for each slide. 

The View tab 
 

 Different views allow you 
to manage different 
aspects of your 
presentation. 

View Tab >> Presentation Views Group 
 

Normal View - Splits the window into Slide Frame, Notes, and the left frame 
where you can choose either Slides Thumbnails or Outline. This allows you to 
focus on a slide and see everything about the slide at once. 
Slide Sorter - Gives thumbnails of all the slides in the presentation. This lets 
you see the big picture. Allows you to sort, move, add and delete slides easily. 
Useful near the end of a project 
Notes Page - Displays a page layout of the notes and the slide. Allows you to 
rearrange the notes and compare them to the content of your slide. 
Slide Show - Plays the presentation from the beginning with animation. 

Turn on/off visual guides View Tab >> Show/Hide Group >> Ruler 
View Tab >> Show/Hide Group >> Gridlines 
 

 Gridlines and rulers are used to measure and line up objects on a slide. 

 
We will return to the View Tab later in this tutorial to explain the uses of the Slide Master View.

View Tab 
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Inserting and Formatting Text and Objects 
 
 
 
 

Add text with Text Boxes 
 
NOTE 
In PowerPoint ALL TEXT  is 
contained in Text Boxes! 

Home Tab >> Drawing >> Text Box    OR 
Insert Tab >> Text >> Text Box 
 

 Click on the Text Box button - Choose Horizontal TextBox 

 In the slide, click-and-drag the mouse to draw a TextBox 

 Drag circle corner points or square side points of the text box to change 
its size. 

 Click within the TextBox to type text. 

Move a Text Box 
 
NOTE: You can move or 
rotate any object in 
PowerPoint using the 
methods described here. 

 Select a Text Box by clicking on it 

 Bring the cursor over the Border of the Text Box 

 The cursor will change to the move icon (2 crossed 
arrows).  

 Click-and-drag with the mouse to move the text box. 
 

 You can also Nudge a Text Box by Selecting it and hitting the arow keys on 
the keyboard. This method offers greater precision in placing an object. 
 

 Rotate the Text Box: 
o Select the Text Box. Notice the green circle directly above the box. 
o Bring the cursor over the green circle. It will change to a rotate icon 
o Click-and-drag to rotate the Text Box. 

Format a Text Box Drawing Tools Tab - Format >> Shape Styles 

 
 

 Select the Text Box. The Drawing Tools Tab appears. 

 Click on the Format Tab. Format the selected Text Box in Shape Styles: 
o Shape Fill - Changes the fill color 
o Shape Outline - Changes the color, width, line style of outline 
o Shape Effects - Applies visual effects (shadow, bevel, etc.) 

Format text in a Text Box Home Tab >> Font Group 

 Select and highlight the text in the Text Box. 

 Click on the Home Tab 

 In the Font Group and Paragraph Group, you can format the Font, Size, 
colour, and style of the selected text. 

Add WordArt - fancy text Insert Tab >> Text >> WordArt  

 Click on the WordArt button >> Select the style you like 

 A WordArt Text Box appears in the slide.Type in. 

Insert Tab 
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Format WordArt Drawing Tools Tab - Format >> WordArt Styles 

 Select the WordArt in the slide.  

 The Drawing Tools Tab will appear at the right end of the 
Ribbon Tabs 

 Click on the Format Tab. 

 Format the selected WordArt in WordArt Styles Group. 

Add shapes Insert Tab >> Illustration >> Shapes 

 Click on the Shape button to see the list of available shapes. 

 Select the shape. 

 Click on anywhere in the slide to insert the selected shape. 

Format shapes 
 
NOTE: You can format a 
Shape as you format a Text 
Box using Drawing Tools 
Tab. See "Format a Text 
Box" on the previous page. 

Drawing Tools Tab - Format >> Shape Styles 

 Select the Shape. The Drawing Tools Tab appears 

 Click on Format tab. Format the selected shape in Shape Styles: 
o Shape Fill - Changes the fill color 
o Shape Outline - Changes the color, width, line style of outline 
o Shape Effects - Applies visual effects (shadow, bevel, etc.)  to the 

shapes 

Lay one shape over/under 
another 

Drawing Tools Tab - Format >> Arrange 

 Select the shape.   

 The Drawing Tools Tab will appear 

 Click on Format tab. Arrange the order in the 
Arrange Group : 
o Bring to front  
o Send to back  

Group, Align and Rotate 
shapes 

 

 
 

 While holding the shift key, click on the objects you wish to group. 
Drawing Tools tab appears. 

 Click on Format tab. 

 To group the objects: Click on Group button in Arrange Group 

 To align the objects: Click on Align button in Arrange Group 

 To rotate the objects: Click on Rotate button in Arrange Group 
Shapes in a group my still be moved and edited individually, and will continue 
to correspond to their group after being changed. 

Add an image from a file Insert Tab >> Illustrations >> Picture 

 Find the picture file you want to insert in the browser window. 

Add an image from Clip Art Insert Tab >> Illustrations >> Clip Art 

 Search for ClipArt and other media in the right-hand search panel. 

 Check in "Everywhere" box under "Search in" for more extensive results  
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Format an Image and Clip 
Art 

Formatting process is basically the same as formatting a Text Box, WordArt, or 
a Shape. 

 

 
 Select an object (Image or Clip Art). The Picture Tool Tab appears. 

 Format objects using Adjust Group, Picture Styles Group and Arrange 
Group. 

 Move objects: See the instructions fpr "Move a Text Box" above. 

Formatting Slide Design 
 
 
 
 
 
 
 
 

Change the Background Design Tabs >> Background >> Background Styles 

 Click on the Format Background  button at the bottom.  

 The Format Background dialog box will appear. 
o You can set the color, solid or gradient, transparency or choose 

picture/texture fill 
o Click the Close button to apply changes only to the current slide 
o Click on Apply to All to apply changes to all the slides 

Change the Theme Design Tabs >> Themes 

 Move the cursor over the theme buttons to Preview different themes on 
your current slide. 

 To choose a theme - Click on any theme button 
o The theme will then be applied to all the slides in your presentation 

 Colors -- Changes the color scheme of the current theme  

 Fonts -- Changes the font of the current theme 

 Effects -- Changes the effects of the current theme 

Formatting Presentation Using the Slide Master 

 

The Slide Master acts as a template for your entire presentation.  
Altering anything on the Slide Master will change the formatting of all the slides in your presentation. 

 
 
 
 
 
 
 
 
 
 
 

Open the Slide Master View Tab >> Presentation Views >> Slide Master  

 The Slide Master Tab appears on the left-hand side of Home Tab 

Design Tab 

 

View Tab 
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Edit the Slide Master  Clicking on the Slide Master Tab provides a set of Slide 
Master Formatting Groups: 

o Edit Master 
o Master Layout 
o Edit Theme 
o Background - set the background for all the slides 
o Page Setup 
o Close -- Click on Close button to go back to Normal View. 

 Choose the top Slide Master Slide in the left panel 

 You can edit the Background, Bullet styles, Slide Titles, and Title 
animations here. 

Objects and Animation 
 
 
 
 
 
 

Create custom animation 
effects for objects 

Animation Tab >> Animations >> Custom Animation 
 

 When you choose the Custom Animation 
Tool, the Custom Animation panel appears 
on the right-hand side of the current slide. 

 Select the object to which you want to apply 
animation 

 Click the Add Effect button and choose an 
animation style.   
o Frequently-used effects are found in 

"Entrance" styles in the menu 

 Click the Play button to preview the 
animation. 

Modify Animation effects and 
order of animated objects 

 Customize animation effects under Modify in Custom Animation panel. 
o Start - how to start the animation 
o Direction - direction of animation  
o Speed - speed of animation 

 

 Change the order in which the animated objects play: 
o Select the object in the list under Modify 
o Hold the mouse on that item in the list and drag it up or down to 

change the order of objects 

Animation Tab 
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Create a Slide Transition Slide transitions are animation effects that appear between slides. While they 
look fancy, these transitions can be distracting if overused. It is often good to 
keep this kind of animation to a minimum. 
 
Animation Tabs >> Animations >> Transition to This Slide 

 Mover the cursor over the transition buttons to preview the effects. 

 Click on the Transition effect button to apply the slide transition effect. 

 Click on Transition Sound button to apply sound effect for transition. 

 Click on Transition Speed button to adjust the speed. 

 Click on Apply to All to apply the same transition effect to all the slides. 

Finishing Steps 

Change the order of the 
slides 

 View Tab >> Presentation Views >> Slide Sorter  
o This view is used to change the order, if you have a lot of slides. 

 Or, select Slides tab in the left frame in the Normal View. You can see 
thumbnails of the slides in your presentation.  
o Click on a slide thumbnail and drag up and down to change the order. 

Make notes Write your notes in the bottom frame in Normal view.  
 
To Print your notes: 

 Office Button >> Print >> Print What:  

 Select "Note Pages" 
 
NOTE: Notes are not visible during the slide show. 

Present the Slide Show Manual Presentation: 
View Tab >> Presentation Views >> Slide Show 
To move to the next slide in your presentation do one of the following: 

 Click the left mouse button 

 Hit the spacebar 

 Use the arrow keys on the keyboard. Up and left go back, right and down 
go forward. 

 Click on the Esc key on keyboard to go back to Normal view. 
 

Automatic Presentation: 
Animations Tab>> Transition to this Slide >> Advance Slide 

 Click on the check box for "Automatically After."  

 Set the time to automatically change to the next slide after a certain 
duration of time. 

 This feature is useful if you are under a time constraint or if you want to 
present in a more movie-like style. 

Save a presentation MS Office Button >> Save As… 
 
In the lab, use Save As… to save your file to: 

 USB drive 

 UVicTemp (I:\ in My Computer) 

  You can also save the file to the desktop and attach it to an e-mail.  
 

Please read the Important Notes on page 3  
regarding saving in Office 2007 

 
Be sure to remember that any files saved to the desktop will be 

automatically deleted after you log off! 
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Additional notes 

If you require technical help with getting your presentation ready (i.e. hooking up a laptop to the video data 

projectors found in most classrooms) give Audio/Visual services a call (721-8292) and ask for a demo. If you 

are giving a presentation in the computing facilities, you can test your presentation in one of the classrooms in 

the facility. Confirming ahead of time that the equipment works with your laptop or CD and is ready to go 

relieves a lot of stress on the day of your presentation. 

To avoid confusing technical problems it is recommended to keep large sounds, pictures and video files in the 

same folder as your presentation file. PowerPoint will look in the same folder as the presentation file or the 

exact folder the file was originally kept for any files linked to the presentation (this includes drive letter).  

 

Thank you for attending our Microsoft Office tutorial series. 

This tutorial was written by staff in the Clearihue Computing Facility.  

Feel free to contact us at 721-7684 or stop by the Facility at Clearihue A112 for further assistance. 

  

 


